
用户指南和产品规范

NI USB-6008/6009
本用户指南主要介绍数据采集 (DAQ) 设备 NI USB-6008/6009 的使用方法

和产品规范。

说明

NI USB-6008/6009 可提供 8 个模拟输入 (AI) 通道、 2 个模拟输出 (AO) 通
道、 12 个数字输入 / 输出 (DIO) 通道以及一个带全速 USB 接口的 32 位计

数器。

注 本文档更新了命名规范，使其与 NI-DAQmx 行文规范一致。表 1 详细给出了新旧

命名规范的对照关系。

表 1 数字输出驱动类型的命名规范

硬件功能 NI-DAQmx 术语

漏极开路 集电极开路

推挽 有源驱动

表 2 NI USB-6008 和 NI USB-6009 的区别

特性 NI USB-6008 NI USB-6009

AI 分辨率 12 位差分，

11 位单端

14 位差分，

13 位单端

最大 AI 采样率，单个通道 * 10 kS/s 48 kS/s

最大 AI 采样率，多个通道（总计）* 10 kS/s 48 kS/s

DIO 配置 集电极开路 集电极开路或有源驱动

* 取决于所用系统。
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图 1 NI USB-6008/6009 俯视图

图 2 NI USB-6008/6009 后视图
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尺寸

图 3 为 NI USB-6008/6009 设备的尺寸图。

图 3 NI USB-6008/6009 设备，以毫米 （英寸）为单位

安全守则

注意 请遵循 NI USB-6008/6009 的使用说明。

安装和使用 NI USB-6008/6009 时必须遵循下文提到的重要安全守则。

注意 请勿尝试采用本文档未提到的其它方式操作 NI USB-6008/6009。错误操作设备可

能发生危险。设备损坏时，内部的安全保护机制也会受到影响。关于受损设备的

维修事宜，请联系 National Instruments。

注意 请勿尝试采用本文档未提到的其它方式替换设备元器件或改动设备。仅可将设备

与安装说明中允许的机箱、模块、附件及线缆配套使用。设备运行期间需关闭所

有盖板和填充面板。

注意 请勿在可能发生爆炸的环境中或存在易燃气体的情况下使用设备。如必须用于此

类环境，请选择合适的外壳。
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63.50 mm
(2.500 in.)

72.65 mm
(2.860 in.)
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76.09 mm
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请使用干布清洁设备。设备恢复运行前，请先验证设备是否完全干燥且不会

产生污染。

设备工作环境的污染等级应小于等于二级。污染是指固态、液态或气态杂

物，它会降低设备的绝缘强度或表面电阻率。污染等级说明如下：

• 污染等级 1 是指无污染或仅有干燥的、非导电性污染。此污染无影响。

• 污染等级 2 是指大多数情况下，仅产生非导电性污染。但需考虑偶然由

凝露引起的短暂导电性污染。

• 污染等级 3 是指导电性污染，或由于凝露使干燥非导电性污染变成导电

性污染。

根据设备最大额定电压，选择相应的信号绝缘线。请勿超出设备最大额定

值。设备接通电气信号时，请勿进行设备连线。如系统已接通电源，请勿卸

除或安装接线盒。热插拔模块时，应避免人体与接线盒内信号接触。设备连

接或断开信号线时，请先移除信号线电源。

设备满足的测量等级低于或等于 Measurement Category I1。测量电路

在测量或测试过程中需承受工作电压2 和来自与其连接电路的电压瞬变 （过

电压）。测量类别定义了配电系统中常见的标准脉冲耐压等级。测量类别的

说明如下：

• Measurement Category I 适用于在与配电系统 （MAINS3 电压）非

直接相连的电路上进行的测量。该类别用于测量受特殊保护的二级电路

的电压。这类电压测量包括对信号电平、特殊设备、设备能量有限制的

部件、由低稳压源供电的电路，以及电子设备的测量。

• Measurement Category II 适用于在与配电系统直接相连的电路上进

行的测量。该类别需参见当地配电标准 （例如，标准壁装插座电源在

美国为 115 V，在欧洲为 230 V）。此类测量包括家用电器、便携式工

具和类似设备的测量。

• Measurement Category III 适用于在建筑物设施中进行的测量。此类

测量包括在硬接线设备 （例如，固定设备、配电板和断路器）上进行

的测量，以及在布线 （例如，电缆、汇流条、开关、固定式插座和与

固定设备永久性连接的发动机）上进行的测量。

• Measurement Category IV 适用于在供电装置上进行的测量

(<1000 V)。例如，电表、初级过流保护设备和纹波控制单元的测量。

1   电气设备安全标准 IEC 61010-1 对测量类别进行了分类，测量类别也称为安装类别。

2   工作电压是指任何绝缘体上可能存在的最大交流电压有效值或直流电压值。
3   MAINS 是指为设备提供电力的危险带电供电系统。符合条件的电路也可连至用于测量目的的 MAINS 系统。
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相关文档

每套应用软件包和驱动程序都包括完成测量和控制测量设备的编程信息。

下列参考文档假定用户已安装 NI-DAQmx 8.7 或更高版本，如使用 NI 应用

软件，其版本应为 7.1 或更高。

用于 Windows 平台的 NI-DAQmx
DAQ 入门指南介绍安装 NI-DAQmx （用于 Windows 平台）和其支持的

DAQ 设备，以及判断设备工作状态的方法。点击开始 » 程序 »National 
Instruments»NI-DAQ»DAQ 入门指南查看文档。

NI-DAQ 自述文件中列出了此版本的 NI-DAQ 支持的设备信息。点击开始 »
程序 »National Instruments»NI-DAQ»NI-DAQ 自述文件查看文档。

NI-DAQmx 帮助介绍测量概念、 NI-DAQmx 重要概念以及适用于所有编程

环境的常见应用程序。点击开始 » 程序 »National Instruments»NI-DAQ»
NI-DAQmx 帮助查看文档。

注 关于非 Windows 操作系统的支持信息，请访问 ni.com/info，输入信息代码

BaseGSGML查询。

LabVIEW
新用户可通过 LabVIEW 入门指南熟悉 LabVIEW 图形化编程环境，

掌握 LabVIEW 创建数据采集和仪器控制应用程序的基本特性。点击

开始 » 程序 »National Instruments»LabVIEW»LabVIEW 帮助查看

LabVIEW 入门指南，或访问 labview\manuals路径下的

LV_Getting_Started.pdf。

在 LabVIEW 中点击帮助 » 搜索 LabVIEW 帮助，通过 LabVIEW 帮助熟悉

LabVIEW 编程理论、编程分步指导以及 VI、函数、选板、菜单和工具的相

关信息。关于 NI-DAQmx 的相关信息，可查看下列 LabVIEW 帮助目录 :
• LabVIEW入门指南»DAQ入门指南—包括软件概述和使用DAQ助手在

LabVIEW 中进行 NI-DAQmx 测量的教程。

• VI和函数»测量 I/O VI和函数—介绍LabVIEW NI-DAQmx VI和属性。

• 仪器测量 — 介绍在 LabVIEW 中采集和分析测量数据的概念及详解，

包括常见测量、测量基础、 NI-DAQmx 重要概念和设备信息。

LabWindows/CVI
LabWindows/CVI Help 中的 Data Acquisition 一章介绍了

NI-DAQmx 测量概念，其中 Taking an NI-DAQmx Measurement in 
LabWindows/CVI 主题包括使用 DAQ 助手创建测量任务的分步指导。

在 LabWindows™/CVI™ 中，点击 Help»Contents, 点击 Using 
LabWindows/CVI»Data Acquisition 查看文档。
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LabWindows/CVI Help 中的 NI-DAQmx Library 一章包括 API 概述和

NI-DAQmx 函数参考信息。点击 LabWindows/CVI Help 中的 Library 
Reference»NI-DAQmx Library 查看文档。

Measurement Studio
如在 Measurement Studio 中使用 Visual C++、 Visual C# 或 Visual 
Basic .NET 为 NI-DAQmx 支持的设备编程，可通过 MAX 或 Visual 
Studio .NET 启动 DAQ 助手，交互式创建通道和任务。在 Measurement 
Studio 中，可根据任务或通道生成配置代码。关于生成代码的详细信息，

见 DAQ 助手帮助。用户可在应用程序开发环境 (ADE) 中使用 NI-DAQmx 
API 创建通道、任务及编写自定义应用程序。

关于 NI-DAQmx 方法和属性的帮助信息，见 NI Measurement Studio 
Help 中的 NI-DAQmx .NET Class Library 或 NI-DAQmx Visual C++ 
Class Library。关于在 Measurement Studio 中编程的帮助信息，见

NI Measurement Studio Help，它集成在 Microsoft Visual Studio .NET
帮助文档中。在 Visual Studio .NET 中，点击 Measurement Studio»
NI Measurement Studio Help 查看文档。

按照下列步骤在 Visual C++、Visual C# 或 Visual Basic .NET 平台创建应

用程序：

1. 在 Visual Studio .NET 中，点击 File»New»Project 打开 “New 
Project” 对话框。

2. 根据所用编程语言选择 Measurement Studio 文件夹。

3. 选择项目类型，添加 DAQ 任务。

ANSI C，未安装 NI 应用软件
NI-DAQmx 帮助包括 API 概述和基本测量概念。点击开始 » 程序 »
National Instruments»NI-DAQ»NI-DAQmx 帮助查看文档。

NI-DAQmx C Reference Help 主要介绍 NI-DAQmx 库函数，可配合 NI
数据采集设备开发虚拟仪器、数据采集和设备控制应用程序。点击开始 »
程序 »National Instruments»NI-DAQ»NI-DAQmx C Reference Help
查看文档。

.NET 语言，未安装 NI 应用软件
如已安装 Microsoft .NET Framework 1.1 或更高版本，可在 NI-DAQmx
中使用 Visual C# 和 Visual Basic .NET 编程语言创建应用程序 （无需

Measurement Studio）。 API 文档需安装 Microsoft Visual Studio 
.NET 2003 或 Microsoft Visual Studio 2005。

文档内容包括 NI-DAQmx API 概述、测量任务、测量概念及函数参考信

息，它集成在 Visual Studio .NET 文档中。通过开始 » 程序 »National 
Instruments»NI-DAQ»NI-DAQmx .NET Reference Help 可查看

NI-DAQmx .NET 文档。展开 NI Measurement Studio Help»
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NI Measurement Studio .NET Class Library»Reference 可查看函数参

考信息。展开 NI Measurement Studio Help»NI Measurement Studio 
.NET Class Library»Using the Measurement Studio .NET Class 
Libraries 可查看 NI-DAQmx 与 Visual C# 和 Visual Basic .NET 配合使用

的相关主题。

如需在 Visual Studio 中查看同一帮助主题，点击 Help»Contents，在

Filtered By 下拉菜单选择 Measurement Studio，按照上述路径查看文

档。

设备文档和产品规范
NI-DAQmx 支持的设备和附件文档 （包括 PDF 和介绍设备端子说明、

产品规范、功能和使用说明的帮助文件）均包含于 NI-DAQmx 光盘。光盘

包含设备文档。插入光盘并访问 Device Documentation 目录，双击

Device Documents 快捷方式，选择所需语言查找、阅读或打印设备文

档。

注 用户也可登录 ni.com/manuals下载文档。

NI-DAQmx Base (Linux/Mac OS X/LabVIEW PDA 8.x)
NI-DAQmx Base Getting Started Guide 介绍安装 NI-DAQmx Base 软

件和其支持的 DAQ 设备，以及判断设备工作状态的方法。在 Windows
中，点击开始 » 程序 »National Instruments»NI-DAQmx Base»
Documentation»NI-DAQmx Base Getting Started Guide 查看文档。

Getting Started with NI-DAQmx Base for Linux and Mac Users 主要介

绍在 Mac 或 Linux 操作系统中，安装 NI-DAQmx Base 软件和其支持的

DAQ 设备，以及判断设备工作状态的方法。

NI-DAQmx Base Readme 中给出了此版本的 NI-DAQmx Base 支持的设

备信息。在 Windows 中，点击开始 » 程序 »National Instruments»
NI-DAQmx Base»DAQmx Base Readme 查看文档。

NI-DAQmx Base VI Reference Help 包含 VI 参考帮助和测量概念的基本

信息。在 LabVIEW 中，点击帮助 »NI-DAQmx Base VI Reference Help
查看文档。

NI-DAQmx Base C Reference Help 包含 C 语言参考帮助和测量概念的

基本信息。在 Windows 中，点击开始 » 程序 »National Instruments»
NI-DAQmx Base»Documentation»C Function Reference Help 查看

文档。

注 用于 Linux 平台的所有 NI-DAQmx Base 文档位于 /usr/local/natinst/

nidaqmxbase/documentation。



NI USB-6008/6009 用户指南和产品规范 8 ni.com/china

注 用于 Mac OS X 平台的所有 NI-DAQmx Base 文档位于 /Applications/

National Instruments/NI-DAQmx Base/documentation。

培训课程
为满足客户使用 NI 产品开发应用程序时的帮助需求， NI 提供相应的培训课

程。登录 ni.com/training可查询课程信息及报名。

网络技术支持
登录 ni.com/support或 zone.ni.com获取更多技术支持。

软件安装

NI-DAQmx 可为 NI USB-6008/6009 提供适用于 Windows Vista/XP/
2000 平台的驱动程序。用户可通过 DAQ 入门指南了解软件 / 硬件安装、

通道和任务配置的分步指导，以及应用程序开发入门。登录

ni.com/manuals可下载文档。

注 关于非 Windows 操作系统的支持信息，请访问 ni.com/info，输入信息代码

BaseGSGML查询。

安装其它软件
如需使用其它软件，见软件随附安装说明。

程序范例
NI-DAQmx 光盘中带有程序范例，用户可使用这些程序范例尝试对

NI USB-6008/6009 编程。相关信息见设备随附的 NI-DAQmx 在 USB 设备

上的应用－入门指南，或通过开始 » 程序 »National Instruments»
NI-DAQ 查看文档。

NI-DAQmx Base 软件随附程序范例，用户可使用这些程序范例尝试对

NI USB-6008/6009 编程。详细信息见设备随附的 NI-DAQmx Base 
Getting Started Guide，或点击开始 » 程序 »National Instruments»
NI-DAQmx Base»Examples 查看文档。

注 关于非 Windows 操作系统的支持信息，请访问 ni.com/info，输入信息代码

BaseGSGML查询。
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安装 NI USB-6008/6009 设备

安装硬件设备前，需安装设备所需软件。详细信息见文档软件安装部分及软

件相关文档。

图 4 为 NI USB-6008/6009 的主要功能组件。

图 4 设备框图
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安装 NI USB-6008/6009 设备
NI USB-6008/6009 的配置步骤如下：

1. 将 Combicon 螺栓端子接线盒插入 Combicon 连接器插座，完成连

接器安装。

2. 图 5 为 NI USB-6008/6009 套件中随附的信号标签示意图。信号标签可

粘贴于螺栓端子接线盒上，以方便信号识别。

图 5 NI USB-6008/6009 信号标签

3. 关于信号标签方向以及粘贴信号标签至螺栓端子连接器的详细信息，

见表 4、图 5 和 6。必须先粘贴信号名称标签，再将插螺栓端子接线盒

插入相应 Combicon 插座。

图 6 信号标签应用框图

1 端子编号标签 （图中端子对需同时使用）

2 数字 I/O 标签
3 差分信号名称标签 （可选）

4 单端信号名称标签 （可选）

1 设备表层标签，带引脚排列方向示意

2 Combicon 连接器插座
3 信号标签

4 USB 线缆

ANALOG DIGITAL1

2

3

4
或

9006-BSUIN

O/InoitcnufitluM,tib-41,stupnI8

23

l ati gi D

71

1

golanA

61
3

2

4

1

2 3
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注 螺栓端子连接器粘贴信号标签后，必须遵照 NI USB-6008/6009 设备的表层标签示

意，将螺栓端子接线盒插至相应 Combicon 插座。

4. 连接导线至相应螺栓端子。

连接 NI USB-6008/6009 至计算机
将 USB 电缆一端连接 NI USB-6008/6009，另一端连接计算机的可用 USB
端口。

LED 指示灯
NI USB-6008/6009 的 USB 连接器附近有一个绿色 LED 指示灯。如表 3 所

示， LED 指示灯用于显示设备状态。设备连至 USB 端口时， LED 指示灯将

有节奏的闪烁。表明设备正在初始化且 USB 端口为设备供电。

如 LED 指示灯未闪烁，表明设备未进行初始化或计算机处于待机模式。设

备连接的计算机应预装 NI-DAQmx 软件，以确保设备可被识别。设备指示

灯未闪烁的情况下，请确认计算机已安装最新版本的 NI-DAQmx，且计算

机未处于待机模式。

表 3 LED 状态 / 设备状态

LED 状态 设备状态

不亮 未连接设备或计算机处于暂停模式。

亮，不闪烁 设备已连接。

单闪 正常工作。
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I/O 连接器

NI USB-6008/6009 随附一个用于模拟信号的可拆卸式螺栓端子连接器和一

个用于数字信号的可拆卸式螺栓端子连接器。端子连接器可提供 16 个连

接，使用 16 AWG 至 28 AWG 导线。

表 4 为模拟端子说明，表 5 为数字端子说明。

表 4 模拟端子说明

模块 端子 信号，单端 模式 信号，差分 模式

1 GND GND

2 AI 0 AI 0+

3 AI 4 AI 0–

4 GND GND

5 AI 1 AI 1+

6 AI 5 AI 1–

7 GND GND

8 AI 2 AI 2+

9 AI 6 AI 2–

10 GND GND

11 AI 3 AI 3+

12 AI 7 AI 3–

13 GND GND

14 AO 0 AO 0

15 AO 1 AO 1

16 GND GND

1
2

3
4

5
6

7
8

9
10

11
12

13
14

15
16
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表 5 数字端子说明

模块 端子 信号

17 P0.0

18 P0.1

19 P0.2

20 P0.3

21 P0.4

22 P0.5

23 P0 6

24 P0.7

25 P1.0

26 P1.1

27 P1.2

28 P1.3

29 PFI 0

30 +2.5 V

31 +5 V

32 GND

32
31

30
29

28
27

26
25

24
23

22
21

20
19

18
17
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信号说明

表 6 详细描述了 I/O 连接器的可用信号。

表 6 信号说明

信号名称 参考 方向 说明

GND — — 地 — 单端 AI 测量的参考地，差分模式测量、

AO 电压、 I/O 连接器的数字输入信号、

+5 VDC 电源和 +2.5 VDC 参考电压的偏置电流
返回地。

AI <0..7> 可变 输入 模拟输入通道 0 至 7— 对于单端测量模式，每个
信号均为模拟输入电压通道。对于差分测量模
式， AI 0 和 AI 4 分别为差分模拟输入通道 0 的
正负输入端。下列信号组也分别对应相应的差分
输入通道：<AI 1 和 AI 5>, <AI 2 和 AI 6>, 
<AI 3 和 AI 7>。

AO 0 GND 输出 模拟通道 0 输出 — 提供 AO 通道 0 的输出电
压。

AO 1 GND 输出 模拟通道 1 输出 — 提供 AO 通道 1 的输出电
压。

P1.<0..3>
P0.<0..7>

GND 输入或输出 数字 I/O 信号 — 可分别将每个信号配置为输入
或输出。

+2.5 V GND 输出 +2.5 V 外部参考电压 — 用于反复缠绕试验的参
考电压。

+5 V GND 输出 +5 V 电源 — 提供 +5 V 电压，驱动能力可达

200 mA。

PFI 0 GND 输入 PFI 0— 此引脚可配置为数字触发器或事件计数
器输入。
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模拟输入

通过 I/O 连接器可连接模拟输入信号至 NI USB-6008/6009。关于模拟输入

信号连接的详细信息，见表 6。

模拟输入电路
图 7 为 NI USB-6008/6009 设备的模拟输入电路示意图。

图 7 模拟输入电路

MUX
NI USB-6008/6009 带有模数转换器 (ADC)。多路复用器 (MUX) 每次将一

个 AI 通道多路复用至 PGA。

PGA
可编程增益放大器配置为差分测量模式时，可为输入端提供 1, 2, 4, 5, 8, 10, 
16 或 20 倍增益选择，配置为单端测量模式时，增益倍数为 1 。 PGA 增益

是根据测量应用选择的电压量程自动换算出的。

A/D 转换器
模数转换器 (ADC) 通过将模拟电压转换为数字编码，实现 AI 信号数字化。

AI FIFO
NI USB-6008/6009 可对固定或无限次数采样执行单个或多个 A/D 转换。

AI 采集过程中，通过先进先出 (FIFO) 缓存存储数据，以确保没有数据丢

失。

AI

+2.5 VREF

39.2 kΩ

127 kΩ

30.9 kΩ PGA

输入量程选择

AI FIFOADCMUX
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模拟输入模式
用户可在 NI USB-6008/6009 上将 AI 通道配置为单端模式或差分模式。

关于单端或差分测量的 I/O 连接信息，见表 6。

连接差分电压信号
对于差分信号，信号正极连接 AI+ 端子，信号负极连接 AI– 端子。

图 8 连接差分电压信号

差分输入模式可测量 ±20 V 量程内的 ±20 V 信号。但任意端子相对于 GND
的最大电压为 ±10 V。例如， AI 1 端子为 +10 V, AI 5 端子为 –10 V，则设

备的测量值为 +20 V。

图 9 20 V 差分测量范例

AI+

NI USB-6008/6009

AI–

电压源

–5

–10

–15

–20

20

15

10

5

0

幅
值
 (

V
) AI 1

AI 5

测量结果
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连接大于等于 ±10 V 信号至任一端子可导致输出箝制。

图 10 AI 端信号超出 ±10 V，输出电压箝制

连接参考单端电压信号
连接参考单端电压信号 (RSE) 至 NI USB-6008/6009 时，正电压信号连接目

标 AI 端子，地信号连接 GND 端子，如图 11 所示。

如模拟输入端子未连接任何信号，且模拟输入端配置为 RSE 时，内部电阻

分压器将把端子浮接电压置为约 1.4 V。连接信号后，此电压不会影响测量

结果。

图 11 连接差分单端电压信号

数字触发器
定义 AI 任务后， PFI 0 可被配置为数字触发器输入。启用数字触发器后，

AI 任务等待来自 PFI 0 端的上升沿或下降沿信号，以开始数据采集。

ai/Start Trigger 与数字源配合使用时，指定 PFI 0 为信号源，并选择上升

沿或下降沿。

–5

–10

–15

–20

20

15

10

5

0

幅
值

 (
V

) AI 1

AI 5

测量结果

AI

NI USB-6008/6009

GND

电压源



NI USB-6008/6009 用户指南和产品规范 18 ni.com/china

模拟输出

NI USB-6008/6009 带有 2 个独立 AO 通道，可产生 0 ～ 5 V 输出。所有

AO 通道输出均为软件定时。

模拟输出电路
图 12 为 NI USB-6008/6009 的模拟输出电路示意图。

图 12 模拟输出电路

DAC
数模转换器 (DAC) 将数字编码转换为模拟电压。

连接模拟输出负载
连接负载至 NI USB-6008/6009 时，负载正极连接 AO 端子，负载接地端

连接 GND 端子。

图 13 连接负载

REF(+) REF(–)
12位
DAC

输出
缓冲器

50 Ω
AO

+5 V

GND

NI USB-6008/6009

GND

AO

负载
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最小化输出信号的毛刺
使用 DAC 生成波形时，输出信号可能出现毛刺。毛刺为普遍现象； DAQ
设备进行电压切换时，由于电荷释放将产生毛刺。 DAC 编码的最高有效位

变化时，产生的毛刺幅值最大。用户可根据输出信号频率和特性，使用低通

平滑滤波器滤除毛刺。关于最小化毛刺的详细信息，见 ni.com/support。

数字 I/O
NI USB-6008/6009 共有 12 条数据线 （P0.<0..7> 和 P1.<0..3>），这些数

据线组成了 DIO 端口。 GND 为 DIO 端口的接地参考信号。所有通道可分

别被编程为输入或输出通道。

数字 I/O 电路
图 14 以 P0.<0..7> 端口为例，给出了端口连接信号的示意图。端口引脚配

置为数字输入和输出信号。 P1.<0..3> 配置方法与此类似。

图 14 负载连接范例

注意 连接超出产品规范中最大输入 / 输出电压限制的信号，将损坏设备和计算机。对

于此类信号连接造成的损害， NI 概不负责。

1 P0.0 引脚配置为集电极开路数字输出，用于驱动 LED 指示灯。

2 P0.2 引脚配置为有源驱动数字输出，用于驱动 LED 指示灯。

3 P0.4 引脚配置为数字输入，经反相器接收 TTL 信号。

4 P0.7 配置为数字输入，经开关接收 0 V 或 5 V 信号。

+5 V

LED

开关

I/O 连接器

GND

P0.0
P0.1
P0.2
P0.3
P0.4
P0.5
P0.6
P0.7

+5 V

LED

1

2

3

4

TTL 信号
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源极 / 漏极
默认情况下， NI USB-6008 DIO 端口配置为集电极开路，工作电压为 5 V，

内部上拉电阻为 4.7 kΩ 。如图 15 所示，连接用户提供的外部上拉电阻可

将每个通道的源电流驱动能力增强至 8.5 mA。

使用 NI-DAQmx API 可将 NI USB-6009 端口配置为有源驱动，工作电压为

3.3 V，源极 / 漏极电流限制为 ±8.5 mA。 DIO 配置的详细信息，见

NI-DAQmx 帮助 。

图 15 连接用户提供的外部电阻范例

按照下列步骤确定外接上拉电阻阻值：

1. 在负载端串联一个安培表。

2. 在数字输出通道与 +5 V 电源间连接一个变阻器。

3. 调节变阻器阻值，直至安培表读数显示为目标电流值。电流值必须小于

等于 8.5 mA。

4. 从电路中移除安培表和变阻器。

5. 测量变阻器阻值。测得的阻值为理论上拉电阻值。

6. 实际应用中的静态阻值应大于等于此理论值。

7. 重新将上拉电阻接入负载电路。

GND

P0.0

+5 V

RpRe

Rl

NI USB-6008/6009

负载

A

+5 V

Port Pad

4.7 kΩ 内部电阻

外接
上拉
电阻
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I/O 保护
请遵循下列守则，以避免 NI USB-6008/6009 发生过压、欠压、过流以及

ESD 事件。

• DIO 通道配置为输出时，请勿连接任何外部信号源、地信号或电源信

号。

• DIO 通道配置为输出时，需考虑连至信号的负载的电流要求。请勿超出

DAQ 设备的限定输出电流值。

National Instruments 对于需要高电流驱动的数字应用，具有几种信

号调理解决方案。

• DIO 通道配置为输入时，确保通道电压低于额定工作电压。DIO 通道工

作电压低于 AI 信号通道。

• DAQ 设备为静电敏感设备，取放 DAQ 设备或进行设备接线时，请确保

人体和设备已正确接地。

上电状态
系统启动或重置时，硬件把所有 DIO 通道置为高阻态输入。即通道输出信

号即不是高电平也不是低电平。通道内部带有驱动能力较弱的内部上拉电

阻。

静态 DIO
每个 NI USB-6008/6009 DIO 通道可被用作静态 DI 或 DO。静态 DIO 用于

监视或控制数字信号。静态 DI 通道的采样和 DO 通道的更新均为软件定

时。

事件计数器

PFI 0 可被配置为反相计数器输入边沿计数任务的信号源。此模式下，使用

32 位计数器对下降边沿事件计数。关于事件定时要求的详细信息，见产品

规范。
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参考和电压源

NI USB-6008/6009 可提供外部参考电压和电压源。除非另外声明，所有电

压均以 COM 端为参考地。

+2.5 外部电压参考
NI USB-6008/6009 通过多态稳压器、放大器和滤波器电路，为 ADC 提供

高精度电压。可将此 +2.5 V 参考电压用作自检信号。

+5 V 电压源
The NI USB-6008/6009 可提供 5 V、 200 mA 输出。此电压源可用作外部

组件电源。

注 设备处于 USB 暂停模式时，禁用电压源输出。

产品规范

除非另外声明，否则下列规范的适用温度均为 25 °C。

模拟输入
转换器类型 ........................................................  逐次逼近

模拟输入............................................................. 8 个单端、 4 个差分，软件可选

输入分辨率

NI USB-6008 ............................................ 12 位差分， 11 位单端

NI USB-6009 ............................................ 14 位差分， 13 位单端

最大采样率 （总计）1

NI USB-6008 ............................................ 10 kS/s
NI USB-6009 ............................................ 48 kS/s

AI FIFO ............................................................... 512 字节

定时分辨率 ........................................................ 41.67 ns （24 MHz 时基）

定时精度............................................................. 100 ppm 实际采样率

输入量程

单端............................................................. ±10 V
差分............................................................. ±20 V 2, ±10 V, ±5 V, ±4 V, ±2.5 V, 

±2 V, ±1.25 V, ±1 V

1   取决于所用系统。
2   ±20 V 是指 |AI+ – (AI–)| <= 20 V。但 AI+ 和 AI– 至地电压必须位于 ±10 V 范围内。详细信息见连接差分电压信号。
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工作电压 ............................................................ ±10 V

输入阻抗 ............................................................ 144 kΩ

过压保护 ............................................................ ±35

触发源.................................................................  软件或外部数字触发器

系统噪声1

单端

±10 V 量程 ...................................... 5 mVrms
差分

±20 V 量程 ...................................... 5 mVrms
±1 V 量程 ......................................... 0.5 mVrms

全量程绝对精度，单端

全量程绝对精度，差分2

模拟输出
模拟输出 ............................................................ 2

输出分辨率 ........................................................ 12 位

最大更新速率.................................................... 150 Hz，软件定时

输出量程 ............................................................ 0 ～ +5 V

1   最大采样率时测得的系统噪声。

量程

常规值
(25 °C (mV)) 温度最大值 (mV)

±10 14.7 138

2   输入电压需小于工作电压量程。

量程

常规值
(25 °C (mV)) 温度最大值 (mV)

±20 14.7 138

±10 7.73 84.8

±5 4.28 58.4

±4 3.59 53.1

±2.5 2.56 45.1

±2 2.21 42.5

±1.25 1.70 38.9

±1 1.53 37.5
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输出阻抗............................................................. 50 Ω

输出驱动电流 .................................................... 5 mA

上电状态............................................................. 0 V

边沿斜率............................................................. 1 V/μs

短路电流............................................................. 50 mA

绝对精度 （无负载）....................................... 7 mV 常规值，

36.4 mV 全量程最大值

数字 I/O
数字 I/O

P0.<0..7> ................................................... 8 个通道

P1.<0..3> ................................................... 4 个通道

方向控制.............................................................  每个通道可通过编程独立配置为
输入或输出

输出驱动类型

NI USB-6008 ............................................  集电极开路 （漏极开路）

NI USB-6009 ............................................  每个通道可通过编程，独立配置
为有源驱动 （推挽）或集电极开
路 （漏极开路）

兼容性 ................................................................. TTL, LVTTL, CMOS

绝对最大电压量程 ........................................... –0.5 ～ 5.8 V，对地电压

上拉电阻............................................................. 4.7 kΩ, 5 V

上电状态.............................................................  输入

数字逻辑电平

电平 Min Max 单位

输入低电平

输入高电平

输入泄漏电流

–0.3

2.0

—

0.8

5.8

50

V

V
μA

输出低电平 (I = 8.5 mA)
输出高电平

有源驱动（推挽）， I = –8.5 mA
集电极开路（漏极开路）， I = –0.6 mA，额定值

集电极开路（漏极开路）， I = –8.5 mA，带外部上拉电阻

—

2.0

2.0

2.0

0.8

3.5

5.0

—

V

V

V

V
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外部电压
+5 V 输出（200 mA 最大值）................... +5 V 常规值， +4.85 V 最小值

+2.5 V 输出 （1 mA 最大值）.................... +2.5 V 常规值

+2.5 V 精度 ....................................................... 0.25%，最大值

参考温度漂移.................................................... 50 ppm/°C，最大值

计数器
计数器数量 ........................................................ 1

分辨率................................................................. 32 位

计数器测量 ........................................................  边沿计数 （下降沿）

计数器方向 ........................................................  递增

上拉电阻 ............................................................ 4.7 kΩ, 5 V

最大输入频率.................................................... 5 MHz

最小高电平脉宽 ............................................... 100 ns

最小低电平脉宽 ............................................... 100 ns

输入高电平 ........................................................ 2.0 V

输入低电平 ........................................................ 0.8 V

总线接口
USB 规范 ............................................................ USB 2.0，全速

USB 总线速率 ................................................... 12 Mb/s

电源要求
USB

4.10 ～ 5.25 VDC.................................. 80 mA 常规值， 500 mA 最大值

USB 暂停模式 .......................................... 300 μA 常规值， 500 μA  最大值

物理特性
尺寸

不包括连接器........................................... 6.35 cm × 8.51 cm × 2.31 cm 
(2.50 in. × 3.35 in. × 0.91 in.)

包括连接器 ............................................... 8.18 cm × 8.51 cm × 2.31 cm 
(3.22 in. × 3.35 in. × 0.91 in.)

I/O 连接器......................................................... USB 串口 B 型接头 , 
(2) 16 针端子连接器接头
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重量

带连接器 .................................................... 84 g (3 oz)
不带连接器................................................ 54 g (1.9 oz)

螺栓端子连线 .................................................... 16 至 28 AWG

螺栓端子扭矩 .................................................... 0.22 ～ 0.25 N · m 
(2.0 ～ 2.2 lb · in.)

安全性
请使用干毛巾清洁模块。

安全电压
仅连接规定范围之内的电压。

通道 – GND...................................................... ±30 V 最大值，
Measurement Category I

Measurement Category I 是指测量与配电系统非直接相连 （MAINS 电

压）的电路。 MAINS 是指为设备提供电力的危险带电供电系统。该类别用

于测量受特殊保护的二级电路的电压。这类电压测量包括对信号电平、特殊

设备、设备能量有限制的部件、由低稳压源供电的电路，以及电子设备的测

量。

注意 在 Measurement Categories II,III 和 IV 中，请勿使用设备连接信号或进行测

量。

安全标准
该产品设计符合以下测量、控制和实验室用途的电气设备安全标准。

• IEC 61010-1, EN 61010-1
• UL 61010-1, CSA 61010-1

注 关于 UL 和其它安全认证信息，请查看产品标签或访问 ni.com/

certification，通过模块编号或产品类型搜索，并在 “ 认证 ” 栏中查看相应链

接。

危险环境
NI USB-6008/6009 未通过用于危险环境的认证。

环境
NI USB-6008/6009 设备只适用于室内。

运行环境温度

(IEC 60068-2-1, IEC 60068-2-2) ............... 0 ～ 55 °C

运行环境湿度 (IEC 60068-2-56) ................ 5% ～ 95% RH，无凝结
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最高海拔 ............................................................ 2000 m （环境温度为 25 °C）

存储温度

(IEC 60068-2-1, IEC 60068-2-2) ............... –40 ～ 85 °C

存储湿度 (IEC 60068-2-56)......................... 5% ～ 90% RH，无凝结

污染等级 (IEC 60664)................................... 2

电磁兼容性
产品设计符合以下测量、控制和实验室用途的 EMC 标准。

• EN 61326 EMC ；最小抗扰度

• EN 55011 放射标准； Group 1, Class A
• CE, C-Tick, ICES 和 FCC Part 15 放射标准； Class A

注 依据 EMC 规范，设备应使用双屏蔽电缆。

CE 规范
产品已达到现行欧盟产品规范的基本要求，并附有 CE 标志。如下所示：

• 2006/95/EC ；低电压规范 （安全性）

• 2004/108/EC ；电磁兼容标准 (EMC)

注 关于合规信息 (DoC)，见产品的合规声明。如需获取本产品合规声明，请访问

ni.com/certification，通过模块编号或产品类型搜索，并在 “ 认证 ” 栏中查

看相应链接。

环境保护
NI 始终致力于设计和制造有助于环境保护的产品。 NI 认为减少产品中的有

害物质不仅有益于环境，也有益于客户。

关于环境保护的详细信息，请登录 ni.com/environment，查看 NI and 
the Environment 页面。该页包含 NI 遵守的环境准则和规范，以及本文档

未涉及的其它环境信息。

电子电器设备废弃物 (WEEE)
欧盟用户  所有超过生命周期的产品都必须送到 WEEE 回收中心。关于 WEEE 回收中心及

NI 的 WEEE 行动，请访问 ni.com/environment/weee.htm。

RoHS
National Instruments  (RoHS)

National Instruments RoHS ni.com/environment/rohs_china
(For information about China RoHS compliance, go to ni.com/environment/rohs_china.)



 

National Instruments、NI、ni.com 和 LabVIEW 为 National Instruments Corporation 的商
标。有关 National Instruments 商标的详细信息见 ni.com/legal上的 Terms of Use 部分。此处
提及的其它产品和公司名称为其各自公司的商标或商业名称。 关于 National Instruments 产品和技
术的专利权，见软件中的帮助 »专利信息、光盘上的 patents.txt文档，或登录 ni.com/patents
查看 National Instruments Patent Notice。

© 2004–2009 National Instruments Corporation. 版权所有。 371303L-0118 2009 年 5 月

技术支持

NI 网站可提供全面的技术支持资源。访问 ni.com/support，您可获取疑

难解答、应用程序开发自助资源，以及来自 NI 应用工程师的电话或电子邮

件帮助。

NI 总部地址：11500 North Mopac Expressway, Austin, Texas, 
78759-3504。 NI 在全球设立的分支机构也将为您提供技术支持。在美国，

可访问 ni.com/support提交服务请求并按要求进行操作，或拨打电话

512 795 8248 获取技术支持。在其它国家或地区，可联系当地办事处获取

技术支持：

澳大利亚 1800 300 800, 奥地利 43 662 457990-0, 
巴西 55 11 3262 3599, 比利时 32 (0) 2 757 0020, 波兰 48 22 328 90 10, 
丹麦 45 45 76 26 00, 德国 49 89 7413130, 俄罗斯 7 495 783 6851, 
法国 01 57 66 24 24, 芬兰 358 (0) 9 725 72511, 韩国 82 02 3451 3400, 
荷兰 31 (0) 348 433 466, 加拿大 800 433 3488, 
捷克共和国 420 224 235 774, 黎巴嫩 961 (0) 1 33 28 28, 
马来西亚 1800 887710, 墨西哥 01 800 010 0793, 南非 27 0 11 805 8197, 
挪威 47 (0) 66 90 76 60, 葡萄牙 351 210 311 210, 日本 0120-527196, 
瑞典 46 (0) 8 587 895 00, 瑞士 41 56 2005151, 
斯洛文尼亚 386 3 425 42 00, 泰国 662 278 6777, 
台湾 886 02 2377 2222, 土耳其 90 212 279 3031, 
西班牙 34 91 640 0085, 新加坡 1800 226 5886, 新西兰 0800 553 322, 
以色列 972 3 6393737, 意大利 39 02 41309277, 印度 91 80 41190000, 
英国 44 0 1635 523545, 中国 86 21 5050 9800


	NI USB-6008/6009 用户指南和产品规范

	说明
	表1 数字输出驱动类型的命名规范
	表2 NI USB-6008和NI USB-6009的区别
	图 1 NI USB-6008/6009俯视图
	图 2 NI USB-6008/6009后视图

	尺寸
	图 3 NI USB-6008/6009设备，以毫米（英寸）为单位

	安全守则
	相关文档
	用于Windows平台的NI-DAQmx
	LabVIEW
	LabWindows/CVI
	Measurement Studio
	ANSI C，未安装NI应用软件
	.NET语言，未安装NI应用软件
	设备文档和产品规范
	NI-DAQmx Base (Linux/Mac OS X/LabVIEW PDA 8.x )
	培训课程
	网络技术支持

	软件安装
	安装其它软件
	程序范例

	安装NI USB-6008/6009设备
	图 4 设备框图
	安装NI USB-6008/6009设备
	图 5 NI USB-6008/6009信号标签
	图 6 信号标签应用框图

	连接NI USB-6008/6009至计算机
	LED指示灯
	表3 LED状态/设备状态


	I/O连接器
	表4 模拟端子说明
	表5 数字端子说明

	信号说明
	表6 信号说明

	模拟输入
	模拟输入电路
	图 7 模拟输入电路
	MUX
	PGA
	A/D转换器
	AI FIFO

	模拟输入模式
	连接差分电压信号
	图 8 连接差分电压信号
	图 9 20 V差分测量范例
	图 10 AI端信号超出±10 V，输出电压箝制
	连接参考单端电压信号
	图 11 连接差分单端电压信号

	数字触发器

	模拟输出
	模拟输出电路
	图 12 模拟输出电路
	DAC

	连接模拟输出负载
	图 13 连接负载

	最小化输出信号的毛刺

	数字I/O
	数字I/O电路
	图 14 负载连接范例

	源极/漏极
	图 15 连接用户提供的外部电阻范例

	I/O保护
	上电状态
	静态DIO

	事件计数器
	参考和电压源
	+2.5外部电压参考
	+5 V电压源

	产品规范
	模拟输入
	模拟输出
	数字I/O
	外部电压
	计数器
	总线接口
	电源要求
	物理特性
	安全性
	安全电压
	安全标准
	危险环境

	环境
	电磁兼容性
	CE规范
	环境保护

	技术支持



